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1. Introduction

Software : Il
NovoSPT

Rel Date:
clease bate September 2009

Licensing Model : |jcense File, On-demand

P ion T :
roduction Team Design and Programming: Alireza Afkhami (M.A.Sc, M.C.P, I.C.D.L, P.Eng)

Similar Programs : NovoFormula, NovoSPT iPhone/iPad App

Updates : click to open

Disclai :
sclaimer click to read(See 4.)

NovoSPT is a computer program for interpretation of Standard Penetration Test (SPT/ DCPT) and
correlating blow counts (N) to soil properties based on more than 300 formulas. It is gINT, Excel
and Microsoft Access database compatible and provides several reporting and additional features.
Please keep your software up-to-date by visiting the program's web page.

Although all efforts have been undertaken to ensure that this software is of the highest possible
quality and that the results obtained are correct, the authors do not warrant the functions
contained in the program will meet your requirements or that the operation of the program will be
uninterrupted or error-free. The authors are not responsible and assume no liability for any
results or any use made thereof, nor for any damages or litigation that may result from the use of
the software for any purpose. All results to be verified independently by user.

&\ NAvATa~R
1 IUYUICTCI ]
software


http://www.novotechsoftware.com/index.php?option=com_content&view=article&id=139&Itemid=208&lang=us
http://www.novotechsoftware.com/index.php?option=com_content&view=article&id=22&Itemid=209&lang=us
mailto:alireza@novotechsoftware.com
http://www.novotechsoftware.com/novoformula/
http://itunes.apple.com/us/app/novospt/id532900056?mt=8
http://www.novotechsoftware.com/updatelogs/novoSPT.txt
http://www.novotechsoftware.com/spt/
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2. References
1- Foundation analysis and design (5th edition)

2- Reliability of shallow foundation design using the standard penetration test

3- A short course in foundation engineering

4- Empirical correlation between penetration resistance and internal friction angle of sandy soils
5- Correlations of soil properties

6- Analysis of spread footing foundations as a highway bridge alternative

7- Correlation of SPT to strength and modulus of elasticity of cohesive soils

8- Piling Engineering

9- Subsurface Investigation and Interpretation of Test Results for Foundation Design in Soft Clay

10- Foundation Design Codes and Soil Investigation in View of International Harmonization and
Performance Based Design

11- Geotechnical engineering

12- Analysis of Bearing Capacity-Driven Pile

13- Correlations between shear wave velocity and in-situ penetration test results

14- Pile foundations in engineering practice

15- BPT-SPT correlations for evaluation of liquefaction resistance in gravely soils

16- Earthquake Engineering: Proceedings of the 11th European conference, Paris, France
17- Canadian Foundation Engineering Manual

18- Energy measurements and correlations of the standard penetration test (SPT) and the Becker
penetration test (BPT)

19- Relating Ka and Ks to SPT blow count and to CPT tip resistance for use in evaluating
liquefaction potential

20- Correlation between penetration resistance and relative density of sandy soils
21- Foundation engineering (2" edition, 1974)

22- Manual on estimating soil properties for foundation design

23- Geotechnical engineering

24- Soft ground improvement

25- Theory and practice of foundation design
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26- A Portable Dynamic Penetrometer for Geotechnical Investigations
27- Soil mechanics in engineering practice
28- A few comments on pile design

29- Evaluation of modulus of subgrade reaction (Ks) in gravely soils based on standard
penetration test (SPT)

30- Use of SPT Blow Counts to Estimate Shear Strength Properties of Soils: Energy Balance
Approach

31- Statistical correlations between seismic wave velocities and SPT blow counts and the relative
density of soils

32- Mathematical Correlations Between The Effective Diameter Of Soil And Other Properties
33- Engineering correlations for soils in Taipei

34- Geotechnical Engineering

35- Dynamic Properties of Fine Grained Soils in South of Tehran

36- Relationship Between S-Wave Velocities And Geotechnical Properties of Alluvial Sediments

37- Site response analyses based on site specific soil properties using geotechnical and
geophysical tests

38- Foundation engineering handbook

39 (sulnl liSGeis sewipo 5> (sSwibiwl JFlawoys slbowl 3985 Gawlosl 5,18
40- Geotechnical earthquake engineering

41- Foundation engineering

42- Earthquake geotechnical engineering

43- Mapping of average shear wave velocity for Bangalore region : a case study
44- Piling engineering (3rd edition)

45- Assessment of shear strength for design purposes

46- The foundation engineering handbook

47- In-situ testing in geotechnics: the main tests

48- NEHRP guidelines for the seismic rehabilitation of buildings

49- Correlacion entre el Valor N del Ensayo de Penetracion Estandar y Velocidad de Ondas de
Corte para Arcillas en Bogota - Colombia

50- Seismic Microzonation of Bangalore
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51- A comparison of pile performance base on static formulas and dynamic load test
52- Research report: standard penetration test (SPT) correction

53- NCEER Workshop Report (1997)
54- Engineering and Design: Bearing Capacity of Soils

55- Geotechnical Engineering Circular No. 5 (Evaluation of Soil and Rock Properties)

56- Experience of Suspension P-S Logging Method and Empirical Formula of Shear Wave
Velocities in Taiwan

57- Statistical correlations of shear wave velocity and penetration resistance for soils

58- The relation of shear wave velocity and SPT for soils in Iran (11th European Conference on
Earthquake Engineering Paris, France)

59- Relationship between the standard penetration test and the pressuremeter test on sandy silty
clays (a case study from Denizli, Turkey)

60- Correlation of standard penetration test and pressuremeter data (a case study from Istanbul,
Turkey)

61- Pressuremeter method for foundation design in Hong Kong
62- Estimation of cyclic strength of sand from self-boring pressuremeter tests

63- Use of SPT Blow Counts to Estimate Shear Strength Properties of Soils: Energy Balance
Approach

64- Evaluation of geotechnical property variability
65- Cone penetration testing in geotechnical practice

66- "Closure: Settlement of Spread Footings on Sand," Journal of the Soil Mechanics and
Foundations Division

67- Potential application of dynamic and static cone penetrometers in MDOT pavement design and
construction

68- Relationship between Low Strain Shear Modulus and Standard Penetration Test N Values
69- Site Characterization - Guidelines for Estimating Vs Based on In-Situ Tests

70- Shear Wave Velocity as Function of SPT Penetration Resistance and Vertical Effective Stress at
California Bridge Sites

71- Empirical correlations of shear wave velocity (Vs) and penetration resistance (SPT-N) for
different soils in an earthquake-prone area (Erbaa-Turkey)

72- SPT Capability to Estimate Undrained Shear Strength of Fine-Grained Soils of Tehran, Iran

73- Development of Empirical Correlation Between Shear Wave Velocity And Standard Penetration
Resistance In Soils Of Chennai City
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for an up-to-date list of references please visit this page



http://www.novotechsoftware.com/spt/
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3. Formulas

For updated and complete list of methods and formulas used in NovoSPT for correlation of soil
properties based on SPT blow counts, please see this page


http://www.novotechsoftware.com/spt/
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4. License Agreement

PLEASE READ THIS END USER LICENSE AGREEMENT ("EULA") CAREFULLY BEFORE
DOWNLOADING OR USING THE SOFTWARE. BY DOWNLOADING THE SOFTWARE, OR USING THE
SOFTWARE, YOU ARE CONSENTING TO BE BOUND BY THIS AGREEMENT. IF YOU DO NOT AGREE
TO ALL OF THE TERMS OF THIS AGREEMENT DO NOT DOWNLOAD AND/OR USE THE SOFTWARE.

The Product is Copyright © 2009 "NOVO TECH SOFTWARE". You may use it and distribute it
according to this following License Agreement. If you do not agree with these terms, please
remove the Product from your system. By incorporating the Product in your work or distributing
the Product to others you implicitly agree to these license terms.

1. DEFINITIONS
1.1. "NovoSPT" or "Software" refers to "NOVO TECH SOFTWARE"’s program, in each case,
supplied by "NOVO TECH SOFTWARE" herewith, and corresponding documentation, associated
media, and online or electronic documentation.

1.2. "Trial Version” means a free version of the Software for personal use only, so identified, to be
used in one computer only and for a period of 14 days. The Trial Version is fully functional with no
restrictions compared to the registered version.

1.3. "Registered Version" means a version which has been bought from "NOVO TECH SOFTWARE".

2. LIMITATION OF LIABILITY
Although all efforts have been undertaken to ensure that this software is of the highest possible
quality and that the results obtained are correct, the authors do not warrant the functions
contained in the program will meet your requirements or that the operation of the program will be
uninterrupted or error-free. The authors are not responsible and assume no liability for any
results or any use made thereof, nor for any damages or litigation that may result from the use of
the software for any purpose. All results to be verified independently by user.

In no event shall "NOVO TECH SOFTWARE" be liable for any damages (including, without
limitation, lost profits, business interruption, or lost information) rising out of 'Authorized Users'
use of or inability to use the NovoSPT, even if "NOVO TECH SOFTWARE" has been advised of the

possibility of such damages. In no event will "NOVO TECH SOFTWARE" be liable for loss of data or
for indirect, special, incidental, consequential (including lost profit), or other damages based in
contract, tort or otherwise. "NOVO TECH SOFTWARE" shall have no liability with respect to the
content of the NovoSPT or any part thereof, including but not limited to errors or omissions
contained therein, libel, infringements of rights of publicity, privacy, trademark rights, business
interruption, personal injury, loss of privacy, moral rights or the disclosure of confidential
information.

3. FOR NovoSPT TRIAL VERSION
(@) The NovoSPT Trial version may be freely distributed, with exceptions noted below, provided
the distribution package is not modified in ANY WAY.
(b) The NovoSPT Trial version may not be distributed inside of any other software package
without written permission of "NOVO TECH SOFTWARE".
(c) The NovoSPT Trial version allows the user to publish its work according to the license
agreement, but nor "NOVO TECH SOFTWARE"” nor any member of the company can be held liable
for the content or accuracy of the publication.

9
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(d) You may use the accompanying Product free of charge for a period of 14 days for the sole
purpose of evaluating the Product. If, after this period, you wish to continue using this Product,
you are required to purchase it. In other case, you are required to remove this Product, in its
entirety, from all computers on which it is installed.

(e) You shall not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse
engineer, or transfer the Product except as provided in this Agreement. Any such unauthorized
use shall result in immediate and automatic termination of this Agreement.

4. FOR NovoSPT REGISTERED VERSION
(@) You may install and use the Software on a single computer; OR install and store the Software
on a storage device, such as a network server, used only to install the Software on your other
computers over an internal network, provided you have a license for each separate computer on
which the Software is installed and run. A license for the Software may not be shared, installed or
used concurrently on different computers.

(b) The NovoSPT Registered version allows the registered user to publish its work according to the
license agreement, but nor *"NOVO TECH SOFTWARE"” nor any member of the company can be
held liable for the content or accuracy of the publication.

(c) The NovoSPT Registered version guaranties to the registered user free updates for a whole
version cycle and for 12 (twelve) months.

(d) You shall not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse
engineer, or transfer the Product except as provided in this Agreement. Any such unauthorized
use shall result in immediate and automatic termination of this Agreement.

(e) Once purchased, the Software may not be return to "NOVO TECH SOFTWARE". The price paid
for the Software is not refundable.

(f) The NovoSPT license is issued for one computer based on the Hardware ID provided by user.
Each transfer of license to another computer, if approved by NOVO TECH SOFTWARE, will be
subject to 20 percent charge based on latest NovoSPT price.

5. TERMS
This license is effective until terminated. You may terminate it by destroying the program, the
documentation and copies thereof. This license will also terminate if you fail to comply with any
terms or conditions of this agreement. You agree upon such termination to destroy all copies of
the program and of the documentation, or return them to the author.

6. OTHER RIGHTS AND RESTRICTIONS
All other rights and restrictions not specifically granted in this license are reserved by "NOVO
TECH SOFTWARE". If you have any questions regarding this agreement, please write to
support@NovoTechSoftware.com

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO
BE BOUND BY ITS TERMS AND CONDITIONS.

10
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5. Contents

5.1 Getting Started ...
When starting a new analysis with NovoSPT, the following steps are recommended:

Step 1: enter input data for the size of the shallow and pile foundations, enter groundwater
conditions and choose SPT correction methods (see more here(See 5.2)).

Step 2: enter subsurface soil layers and SPT blow counts in the corresponding tables, as shown
below. Notice the plots on the right -hand side of the page are updated as you enter data (see
more here(See 5.2)).

Step 3: when data entry is over, click on the depth row in the 'SPT Blow Counts' table to choose
the depth in which youneed the correlations. Then click on 'Correlate Soil Parameters' button to
see the correlated soil properties (see more here(See 5.6.2)).

click to update click for help

step 2

Tables Graphs Tools Help

nput fota | Comlated Soi Parameters @ Z=2 74 m, N60=16

Shallow Footing Please enter soll layeang and SPY data. Then click on the comesponding row on SPT table to choosa the depth for which you need the
& calculations. Press "Comelate ers” button for resuts:
B(m): 06 Lim)e: 09

SPT Blow Counts SPT Corraction Factors
5 10 15 20 25 30 3 05 1 15 2
0

ol layers {starting from the extsting ground O
Thickness | Unit Weight
(m) {kN/m3)
2 165

P(Fa): 100

Soil Type

Shear Falure Safety Factor: 3 ey SPT plots

Sand

=

et

Pile Foundation 24

Diameter (m):

SPT Corrections

V' Apply All Corrections
Energy Level (%)
Barehole Diameter (mm):
Sampling Method:
Overburden Correction:
=, Settings

V| Groundwater Leved (m):

step3

60

65-115
Standard. ., ~
Pedcand.. ~

.3}

V| Apply Water Level Correction (for N60 > 15)
Fiter comelations for sol type

& Correlate Soi Parameters

187

18

Sat

Gravel

Depth | SPT Blow |

{m)
]

Counts (N)

c

075
075
075
075
075
075
075

075

075
076

082
084

C:\my programming files\Source Codes\VB Net'\NovoSPT\bin'\Debug'\Example 1 3pt

file path

please note that:

srpmpuip by e O
B ——

PP

LT IT 1T e =

-t SPTN
st SPT NGO=N Ce Cs. Cr Cb
wtine SPT N1(60)=N60.Cnn

weges Cn
w e CrCs Cb.Ce

|zmc

licensee

e by clicking on any chart(See 5.7.4) you will have access to several options for printing and

exporting the chart
e ? sign at the top-right corner of each page, opens up the corresponding help page

11
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e analysis files are saved with .SPT extension and the complete file path is shown at the

bottom of the page

e if an update of the software is available, click on the yellow link at the top-right corner of
the page to open the webpage

5.2 Data Entry

All data entry in NovoSPT is performed in Input Data tab. This data can be categorized into the

following groups:

Shallow Footing:This data is used for calculating bearing capacity of shallow footings
based on shear failure or settlement criteria (based on method).
Footing size and load as well as safety factor against shear failure
should be specified. Please notice that depth of footing (Df) is
considered to be the depth (Z) selected by user on SPT table.

»Results are presented in "Correlated Soil Properties(See 5.6.2)" tab
when "Bearing capacity of footings on sand (ga)" items is selected
from the list.

Pile Foundation:Diameter of the pile should be specified in order to estimate the
friction and end bearing of the piles based on SPT blow counts. Please
notice that pile length is considered to be the depth (Z) selected by
user on SPT table.

»Results are presented in "Correlated Soil Properties(See 5.6.2)" tab
when "Bearing capacity of piles" items is selected from the list.

SPT Corrections:The following corrections should be applied on SPT number (N) to
obtain Neo and N1y numbers:

Energy level: this will adjust the SPT equipment energy to
standard 60% energy. This correction factor is named Ce in
NovoSPT.

Borehole diameter: size of the borehole affects the SPT blow
counts. This correction factor is named Cb in NovoSPT.

Sampling method: some SPT samplers have a liner. This will
affect the SPT blow counts and its correction factor is called Cs
in NovoSPT.

Rod length: this correction factor is called Cr and depends on
length of SPT rods which is approximately equal to the depth of
the test. The following formula proposed by Dr. Cetin is used in
NovoSPT:

1

L]
W
Il
ad

for
431663223
0989360731+ ————

-
S

Overburden stress: this corrections is usually called as "depth
correction factor" or Cn and depends on overburden stress due
to soil, at the test depth.

Please choose your favorite method for each correction factor. The
following formula is used to calculate the correction factors at each

12
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Settings:

Soil Layers:

SPT data:

depth:
C=Ce.Cb.Cs.Cr Neo=C.N N1(60)=Cn.N60

All the above-mentioned factors as well as Ngo and N1 are plotted
versus depth and presented on screen.

»Results for Cn corrections are presented in "Correlated Soil
Properties(See 5.6.2)" tab when "Overburden correction factor (cn)"
items is selected from the list.

The groundwater level affects the calculation of effective overburden
stress (c'y) used in the correlations. In addition, user can choose to
apply the water level correction on SPT blow counts, as proposed by
Terzaghi. This correction is recommended for N>15 in silty sands:

Neor=15+0.5(Ngo-15)

Another important point when using the correlations is 'applicability' of
each correlation to soil type. For example if at depth of 3.4 meters
where correlations are required, the soil type is generally "clay", a
shear wave velocity correlation which is derived in "sand" would not be
reliable and can provide somewhat wrong values. Some other soil
parameters such as undrained shear strength are even meaningless for
"sand" and "gravel" soil types. To filter the correlations based on each
layer's soil type, click on "Show only applicable correlations". To read
more details about this new feature, please read this page(See 5.6.1).

»Please notice that NovoSPT can provide correlations, either at a

specific depth or along depth of the borehole(See 5.6.4). All

correlations regarding a specific depth are presented in "Correlated

Soil Properties(See 5.6.2)" tab and user should specify the depth at

which, correlations are to be calculated. To do this, please click on the

desired depth at SPT data table and notice to the change in and
fields on bottom-left of the page.

This data is used to calculate the effective and total overburden stress
at each depth where correlations are required. Please pick the soil type
for each layer from the dropdown list (clay/silt/sand/gravel) and avoid
details descriptions such as "sandy clay with gravel", etc. This soil type
is used by NovoSPT when correlations are to be filtered based on soil
type(See 5.6.1).

Some SPT correlations depend on OCR and Dsg of the soil. These
parameters should be specified for each soil layer.

»This data can be entered manually or maybe imported from a text
file(See 5.7.1) or from gINT database(See 5.7.2).

In this table please enter raw data gathered from SPT test. The first
two columns of this table include depth and SPT blow counts (N) and
the other columns are automatically calculated during data entry.
While this data is being entered, SPT plots are updated and present
both SPT blow counts and correction factors along depth of borehole.

»This data can be entered manually or maybe imported from a text

13
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file(See 5.7.1) or from gINT database(See 5.7.2).

Note: Never enter zero for a SPT test depth; it may lead to calculation errors (because of
dependency of most overburden pressure corrections to o, which will be zero at Z=0).

Clearing tables data

For clearing all data entered in a table, simply press % button on top-right side of the table.

Shallow footings bearing capacity and settlement

If you want to estimate the bearing pressure and settlement of foundation based on SPT blow
counts, enter corresponding data. For most of these calculations, average of Nggor N1(go) should
be calculated for a depth ranging from 0.5B to 2B underneath the footing. So make sure that you

have entered enough data within this depth range. You may also click on Tools » Bearing
Capacity Analysis menu to use NovoSPT's comprehensive analyses tool.

B: Footing width

L: Footing Length

Df: Depth of embedment for the footing (will be equal to the depth selected by user - see
below)

P: Stress below the footing

SPT graph

Once you enter SPT versus depth data, and press Correlate Soil Parameters button, SPT graph
is updated and un-corrected as well as corrected SPT numbers are plotted versus depth. Another
graph shows the variation of SPT correction factors against depth. Click on each graph to zoom,
print or export to other formats.

IMPORTANT
How can I choose the depth in which I need the correlations?

When data entry is finished, simply click on the row in the SPT table at which depth you need the
correlations. Notice that corresponding depth and SPT data is updates on the 'Correlated Soil
Parameters' tab (see Figure below). For example, the following screenshot shows that N60=8 at
Z=1.52m is chosen and once user clicks on Correlate Soil Parameters, all correlations will be
provided for this depth (read more about filtering correlations(See 5.6.1)).

In this example, for shallow footing bearing capacity analysis Df=1.52m and for pile bearing
capacity pile length=1.52m will be considered.

14
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File  Wiew  Tables Graphs  Tools  Help

TH -2 778 Kl & a0

[nput D ata | Comelated Sail Parameterd @ £=1.52 m |

El . Shallow Footing

e L {m): 0.9
B, e oo ara T
Sampling Method: Standard... ~
Crverburden Correction: Peck and... ™
E . Settings
o | Groundwater Lewvel (m): 3.3

o | Apply Water Level Carrection (For ME0=15)

Filter correlations for sail pe

a Correlate Soil Parameters

5.3 Changing Units System

Pleaze enter zoil lapering and SPT data. Then click on the corezponding row on
calculationz. Press "Carrelate Sail Parameters’ buttan for results:

I walues from SPT in-zitu tests:

D s

Depth | SPT Blow s
{n'f} Counts (n) | M60 Cn c |= _ 1
0.3 ) B 2 0.75 4l
0.61 9 7 2 0.75 o
0.41 11 g 2 073 =
179 12 q 2 07s
152 10 s es sl L 5
T3 7 T Trr i I
213 9 7 152 0.75 \
244 12 a 1.49 0.75 6 |
274 22 16 1.37 0.75
3.05 20 15 1.27 0.75 ]
1R i0 14 440 n T B

NovoSPT supports both Metric and Imperial units. To switch between units system, please use
Tools » Preferences menu and click on User Interface tab.

You should restart the program for the new units system to take effect.

5.4 Toolbar & Menu

Most of the commonly used commands in NovoSPT are placed in toolbars. For other commands
use menu bar. In each form, to read the user manual (Help) content for that page, click on ?
button on top-right corner of the page.

Menu bar Toolbar

Click this button
to get Help

*'J SPTS{onelations Pragram MovoSPT (Full) 2.L0.15 [

‘D-ﬂhl

[Flle  wiew Tables Graphs  Tools  Help|

R - 238FV=H WU &

9|

5.5 Using Help
Activating Help

Help button is placed at the top-right
corner of all pages, as shown on this
screenshot. In order to get the help
content associated with the page,

15

@ 2009-2010 Move Tech Software Ltd, All rights reserved 7

NovoTech|



NovoSPT User's Manual (Novo Tech Software Ltd.)

please click on this button.

How to Choose Help Language?

Most of our help files are available in sphs  Tools [ |

both English and Spanish language. [@ N ] v Engish
In order to choose your desired 7] User Manuals (PDF) S
language please click on | Help » =

= Tutorial Yideos
Help Contents menu and choose your

language from the list. Please notice @ License Agreement
that Help language could be different " License Manager
from the program user-interface

language(See 5.8.4).

The entire help content is also
available in PDF format and is
presented through E!I User Manuals
menu as shown on the right.

Mova Tech Website

@
# Contack us!
@

Abouk

5.6 Results

5.6.1 Soil Type Filtering
This feature can be activated by selecting "Show only applicable correlations" checkbox on input
tab. If this option is activated, the "fbutton on toolbar will be highlighted.

Obviously, any SPT correlation is derived based on case studies or field test in specific soil types.
Most of the SPT correlations are only valid for one or two soil types. In NovoSPT 2.1 and later, the
applicable soil types are specified for each correlation, as it can be seen in the following
screenshot:

soil type filter
is active

rie NI tardpi (NN ] gy
¥ ,Aa o i WOQ oS0

| [nput D ata |

orrelated Soil Properties |

Following corelations are calculated for £2=1.83m ., Effective Stress = 30.2 kPa
MHE0= M1[B0]™9 after Peck and Bazaraa, 1963
? Show all SPT comelations for: | Shear Wave Velocity [Vz] v! |F'%, Depth Carrelatio
Shear Wave Yelocity (¥s) m/s Clay Silt Sand Grel Comments
JR&. 1980 ® |17 of for clays
Ohba and Taoriuma, 1970 133
[yizan 118 o o & o |forallzals
=l - e R Puhlir: Wnrk = Rezearch Inztibute nf
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Blue checkmark: valid for clay

Purple checkmark: valid for silt

Blue checkmark: valid for sand
checkmark: valid for gravel

Gray checkmark: the author has not clearly specified the soil types for this correlation. In this
case NovoSPT assumes that the correlation would be applicable to all soil types

Why using the 'soil type filter'?

Although not applying the soil type filter, provides you with more correlations for a SPT blow
count, it should be noted that not all of the correlations are valid for all soil types. For example, in
a sand layer with a SPT blow counts of Ngg=12, NovoSPT may provide a value for undrained shear
strength (Su) at this depth if soil type filter is off (because you have asked the program not to
check the soil type). But this is totally meaningless!!

You can prevent such confusion and simply concentrate on those correlations which are valid for
the soil type at each depth. Since user has specified the soil layers in input form, it can easily
filter the applicable correlations, during the calculations. If soil type filter is active, a funnel icon
will be highlighted on toolbar and will be shown above the correlation grid.

5.6.2 Correlated results

When data entry in NovoSPT is done, pressing | Correlate Soil Parameters button will show the
correlated results in "Correlated Soil Properties" tab. NovoSPT uses more than 250 correlation(See
3.) formulas to prepare these results. For each soil property (e.g. "Relative Density (Dr)"), all
available correlations are summarized in a table describing Reference, value and comments
regarding each formulae or correlation used. The following picture describes parts of the
correlation grid:
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21}
!

lation

select soil comments for this
parameter correlation

If selected, correlation
sol roe of correlation
(sclentist name)

soil type for which,
correlation is valid

participates in
correlated value

statistics analysis
reference # for

correlation s developed
corre

country in which the
shows if NGO 5 used in
orrelation or N1{&0

= o

Show all 5PT corelations for: |Sh ¥ - |F%\, Depth Comelation| |, Sha Stati&tics|

L [] + N

Shear Wave Velofity [(¥s) m/s Clay Silt Sand Grvl Comments Ref# ¥ar.

o

e

ar ' ave Welociy

R ] i
JRA, 1530 ® | 145 J for sands 40 HED

Ohba and Toriuma, 1370 146 4957 NED
[vizan 130 o o o |forallsoils 1357 HED
Weits s s s ® |135 FPublic "worksz Research [natitute of 6 NED

Japan
) Baziar, Fallsh, Razeghi and s, - of o o of |forall soilz in Dran ffunchion of depthl &3 N1IED)

Each method may be turn on/off by using the checkbox in the first column and will be
added/removed from the statistics chart.

To view the statistics of all correlation for selected soil parameter, click on Show Statistics
button (read more(See 5.6.3)). If correlation of selected soil parameter in depth of borehole is

required, click on Depth Correlation button (read more(See 5.6.4)).

How to copy table contents

If necessary, you can simply copy data within each table by selecting the target rows (by holding
left mouse button down and selecting the rows), and then pressing CTRL+C. Thereafter, pressing
CTRL+V in any other editor in Windows, pastes the data.

How to export the tables into Microsoft Excel

Click on the table, and then select Tables » Save As MS Excel ... menu. Choose the file name
and path in the dialog and the table will be saved as an Excel file.

Visualization of correlated values

To better visualize the results of a specific soil property, a graph is presented on statistical
chart(See 5.6.3). This graph shows scatter of the results for each soil parameter and helps user to
compare those values and pick the most reasonable range for that parameter. Please notice that
for those formulas which provide a range for the parameter, the corresponding value in graph is
shown as a vertical bar representing the minimum and maximum recommended range. To view
additional information, move the mouse over each point on the graph to get more information
about the method.

5.6.3 Statistical report
To better visualize the results of a specific soil property, a graph is presented on statistical chart.
This graph shows scatter of the results for each soil parameter and helps user to compare those
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values and pick the most reasonable range for that parameter. Please notice that for those
formulas which provide a range for the parameter, the corresponding value in graph is shown as a
vertical bar representing the minimum and maximum recommended range. To view additional
information, move the mouse over each point on the graph to get more information about the
method.

Variable Value
500 [ &) Mumber of correlations 59
480 .. -
o Minimum 76
460 Maxdmum 497
5 440 ce Mean 27733
g 4o Median 291
! 400 Variance 84145
w20 o o ° Standard deviation 31.73
‘2 360
= ¢ @ %
:"g 340 . L 2
=320 * a0 - B
8 200 & te o &% ;
= L] <
= 280 . * 3
2 ¢ \J
3 260 . @ + & 5,
= 240 + & " o |
3 +* @ & =5
2 520 & o 5
] =3
200 L & g
< [
180 * & 2
160
o
140 ¢<><> 1
120 * H"
100 ¢¢‘ 0 i< - -
80 ] 0 200 400
Value
[ Legend [F] Palar View i
Please click on chart in order to export the results to other formats including Excel and image files 9 Closs |

Click on each chart to open the chart in Chart Presentation Tool(See 5.7.4) and you can export
and print the data into other formats.

5.6.4 Correlation with depth

This feature is designed to plot the variation of a soil parameter in depth of a borehole based on
SPT blow counts, and is accessible from kI View » Correlation versus depth of the borehole menu.
Follow these steps to obtain the correlation in depth of borehole:

1. Select the desired soil parameter (shear wave velocity is selected in the following
screenshot)

2. Select the correlations from the list (two of the selected methods can be seen in the
screenshot)

3. Click on Plot Selected Methods button and wait for the graph to be updated
19
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4. 1If necessary, remove any or select more methods from the list and repeat step 3

MNovoS
Comelation with depth |
Use this feature to plot comelation of a seil paremeter according to selected methods in depth of borehole; input SPT data is taken from input tab: V
Select soil parameter: . .
Owerburden Comection Factor {Cﬂ] -~ & 30 4an RBI%IE.I& DEI'IGSIW tDTg of Sggd ¥ 40 100
(Other Comection Factors =l 2 o
Consistency = I
Young's Modulus {Es) E i
Friction Angle | i
Relative Density (Or) of Sand 2 A
Undrained Shear Strength (Su) of Clay/Silt < ey
Shear Wave Velocity (Vs) 2 ar
Shear Modulus (Gmax) .
Lguefacton(CRR} | B
Becker Hammer Test (BFT) 3
Pressure-meter Test ¥
F E
Select comelation methods to compare: i@ Plot Selected Methods I =4
[=%
Source Comments i 3
5 BT
[¥] Gibbs and Holtz, 1957 ._.*""
5
Meyerhof, 1957 3 G .n‘:
E "
Yoshida et al., 1988 with Co=25, C1=0.12, C2=0 .46 2
Idriss and Boulanger, 2003
[ Jgiolkowski, 1988 & Skempton. £ __..i 8
. . == Gibbs and Hollz, 1957 {}
[ ._fggénlkmkh 1988 & Skempton. e sands = @ = Meyerhof, 1957 ()
wases Yoshida et al, 1988 (with Co=25, C1=0.12, C2=0.46)
[l rohrinoareli snd lohihsrs 10080 Ml sznds i ldriss and Boulanger, 2003 ()
[ Select None | [ Select All | Legend
Please click on chart in order to export the results to other formats including Excel and image files a Close

For example in the above screenshot, 4 methods are selected and plotted along depth of
borehole. The red and green lines (Yoshida et al., 1988 and Meyerhof, 1957 methods) provide
comparatively lowest and highest values of Dr, respectively.

Note : Please notice that in this example, the funnel icon on top-right corner of the page *r
indicates the soil type filter(See 5.6.1) is ON. This means that only those correlations which are
derived for the same soil type will be listed at each depth. Soil type at a depth is obtained from
soil layers input data(See 5.2).

5.7 Import / Export

5.7.1 Import from text file
In case that there are large number of records for soil layers and/or SPT data, user may import

data from Text files (*.txt) using @ button above the tables . The Text file should have the
following format :

20



NovoSPT User's Manual (Novo Tech Software Ltd.)

one record per line and two numbers on each line separated by comma or tab. For instance, if
your SPT data is stored in a Text file, it looks like the following:

File Edit Format View Help

.3048 19
.6096 19
L0144 11
. 2192
. 524
.B2EE
L1336
L4384
L7432
.048

0
0
]
1
1
1
2
2
2
3
4

where, 0.3048,0.6096,0.9144,etc are depths and 19,19,11,etc are corresponding blow counts per
foot (N). Text files can be easily generated using Windows Notepad or by exporting your data
from spreadsheet applications such as Microsoft Excel into text format. For soil layers text file,
each line consists of layer thickness, its unit weight , soil type , D50 and OCR separated by
comma.

Note: Importing from file is mostly used when you have many rows of data; if your geotechnical
model is simple, just enter them in the tables, manually.

Importing data from gINT, LogPlot, WinLog, LogDraft files

NovoSPT also supports import from above-mentioned files. So if you have already prepared this
files for your project read more about this feature here(See 5.7.2) to find out how to import data
files directly into NovoSPT.

5.7.2 SmartSync (gINT, GeoSystem, GAEA)
NovoSPT supports most of the well known log drafting programs such as gINT, LogPlot, WinLog

and similar programs. To import a gINT project data into NovoSPT, simply click on «# button from
the toolbar or select File » Import from » gINT menu.

When "Open database file" dialog appears, choose your gINT file (*.gpj) from your hard disk.
Next step is to specify where SmartSync can find data such as ground water level, borehole data,
soil layering data and so on. If your gINT file structure is customized by you and does not follow
the default database format, you will then need to choose the corresponding tables and fields in

which specific data can be found. Select desire borehole and then press Import button. All

corresponding data will be imported to SPT table in main page of NovoSPT.
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#You can specify depth unit of your original gINT file. Data will be automatically converted to
your default NovoSPT unit system.

®0nce you set the tables and fields name, you may select the "Remember This Settings"
checkbox so that next time when you import from a gINT file, your setting will be automatically
loaded.

Read Online Help

5.7.3 Exporting Tables and Graphs

Most of the users have already setup their spreadsheets and would rather keep their reports in
the same format. To do this, they need to export the analysis results into other popular formats
such as Microsoft Excel.

To export the results click on [#button form toolbar. A dialog similar to the following screenshot
will appear. List of all tables and charts of the analysis results, will be provided on left and right
panels, respectively (see below).

il B

Flease specify the tables and graphs you want to be exported. All files will be saved in the
following folder:

Cutput folder: aming\Mowvo Tech Software Ltd\NovoSPT2.40.2012.330%_Export), |E]

[ Tables ﬁ, Charts
1 - Soil layers table 1 - SPT graph
[C] 2 - SPT blows table [] 2 - inferred parameter graph

D 3 - Shear Wave Velocity (V=) correlations

ke [] 3 - Depth correlation graph

| @ Save As Excel File ‘ ‘Jm Print

‘E Save As Image File ‘ ‘Jm Print

Please specify the output folder (You can change this folder by clicking on ... button). Then select
the items you want to export.

Exporting Data Tables
Tables can be saved as Microsoft Excel or may be directly sent to the printer.

Exporting Graphs (Charts)
All charts may be saved with image formats such as BMP, PNG, JPG, etc or be printed.
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5.7.4 Graph Presentation Tool

We understand that presentation of the analysis results is very important to our users.
Everywhere in Novo Tech Software programs when you click on a chart, a new dialog appears
containing the chart and its associated data. In the following example, the corresponding dataset
is shown on right and can be scrolled horizontally and vertically to view all data. In addition,
toolbar buttons provide you with more features:

MNowoSPT 2.40,2012.330

n—-c‘rl
[lanad}

S EHE-4 e

SPT Blow Counls
5 10 15 20 25 30 35 40 45 50 55
[| L i i L i i i i L Il

=k
T

Select :

5T -
Depth (m) | SPT Blow Counts |
03 34
0.61 12

0.91
123
1.52
1.83
2.13
244
2.74
3.05
3.33
3.66
3.96
4.27
4.537
4.88
318
349
379
6.1

6.4

23

18
26
23
25
43
ps
21
17
18
20
15
25
23
24
25
72 |
24
24
26
28

m

To change line
styles of the plot

To change the scale
(minimum,
maximum and
gridlines) of each
axis. Please click on
small arrow on right
side of the icon to
open the dropdown
menu

To toggle between
normal/logarithmic
scale for horizontal
axis

To change the chart
type

To open the
advanced settings
page for the chart
To save the dataset
table as Microsoft
Excel file

To save the chart as
text and graphic
format

To print the chart

Opens this help
page
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How can I change the appearance of the chart such as legend, chart type, etc?

You can configure almost everything in the chart by clicking on “#button from the toolbar. This
will open the following dialog box:

[ %5 Chart Presentation Tool | = = 22 |W
v ||| 6 | EEH~S @
Select
% 5 10/05 20 25 30 35 40 45 50 55 Eall )
i—: ’ / T _:__,. W _ . Depth (m) |SPTBlow Counts |
g = 03 34 L

™
o
[¥1]
=1
o
o
o
f
3
o
LA
||

=) Data

I_— @i| Binding = - i F'/\J/
..l DataTable A~
Pods
[||| Gridlines

¥-Y chart, lines, symbols
{Click here to update sample data)

Apply |

Click on the desired element from the list located on the left side of the page; more options will be
shown on the right portion. Click on OK button to apply your changes.

5.8 Tools

5.8.1 Wildcat Penetrometer Module

If you use Wildcat Dynamic Penetrometer (produced by Triggs company in US), this module helps
you process and correlate Wildcat blow counts to equivalent SPT blow counts. Please enter depth
of test and corresponding Wildcat blow counts in first 2 columns of the table. The other
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parameters including equivalent SPT blow counts will be calculated immediately. To transfer the
correlated Ngp obtained from Wildcat, to the NovoSPT main page click on k_l Accept Data button.

Delete Import data  Project Opens
Row {SmartSync)  Info this page

€3 NovoSPT - Wildcat Dynamic Penetrometer

by [ o - B = @ Help

eferences

Clears Import from Export  Print Wildcat
Alldata TEXT file resuis Lag

5.8.2 DCP Module

i hl
Coeewwe . . . wa
> B x| Se
Preferences ) . Blow Counls [N)
Depth comection method for SPT: Log page depth (m): ] 0 5 10 15 20 25
|Gibbs and Holz, 1857 - S0
&
=] 1
Please enter DCP blow counts in the table: :"' .
B
Depth DCP . SPT Correction . B - i
m) Blows Soil Class ‘uen ‘Fa::’tor(:n ‘m:en: ‘SoHConslstency | Z s
05 5 B-95% compacted soil 5 2 9 Medium /Loose h
4
1 2 B-95% compacted soil 3 2 13 SoftVery Loose
5
15 1 B-95% compacted soil 3 2 13 SoftVery Loose
. = 3
2 & C-90% compacted sail 7 2 14 Medium /Loose B
. E7
25 2 | C-90% compacted sail |;I ) 2 18 Siiff/ Loose £
. @ B
3 7 A-Virgin Piedment soil 9 2 19 Stiff / Loose a
B- 85% compacted soil Medium /L 9
15 5 | C-90% compacted soil 7 2 15 Felum fLopse L
D- 85% compacted sail Soft fVery Loose 10 S
4 2 E- Coastal plain soil 4 2 7 o
45 9 i F- Piedmont alluvium 10 5 19 Stiff / Loose
. . 12
5 11 F-Piedmont allwvium 1 2 2 StiMedium Dense (Compact)
, 13—
55 12 A Virgin Piedment soil 9 2 18 Stiff/ Looss
- 14
6 % A Virgin Pisdment soil 7 195 13 Medium /Loose
. 15
65 5 A Virgin Pisdment soil 5 1.85 10 Medium /Loose
= g== DCP Blows N
. . Medium / Loose wizie Ef). SPT Blows NGO
- 8b% . -
7 3 D- 85% compacted soil 4 177 7 —— Corracted SPT Blows N1(60)
- . JE— - - P . Medium / Loose S

+"  Accept Data

(@ s this my DCP? checkout the DCP specifications here le
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If you use DCP (produced by Durham Geo Slope company in US), this module helps you process

and correlate DCP blow counts to equivalent SPT blow counts. Please enter depth of test and

corresponding DCP blow counts and soil class (A to F) in first 3 columns of the table. The other

parameters including equivalent Ngo and Ny Will be calculated immediately. To transfer the

correlated Ngo obtained from DCP, to the NovoSPT main page click on Accept Data button. The
following chart presents the correlations between DCP blows per increment and standard SPT blow

counts for different soil types.

20
15 —
/
F .l /ﬁ,/,-—/
10 ~ B / ;

(jooy sod smo|q)

8oue)sisay N, Piepuels

A - Virgin Piedmont soils
B - 95% Compacted soil
C - 90% Compacted soil
D - 85% Compacted socil —
E - Coastal Plain soils
F - Piedmont alluvium

| |

o
(%]

10

15 20 25

Cone Penetrometer Resistance
(blows per increment)

For the complete reference please read this paper:

®ASTM Special Technical Publication #399: Dynamic Cone for Shallow In-Situ

Penetration Testing
by: George F. Sowers and Charles S. Hodges
Download link for user manual (Durham)
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5.8.3 Bearing Capacity

5.8.3.1 Bearing Capacity Module

For a discussion on bearing capacity methods used in NovoSPT please read this article(See
5.8.3.2).

5.8.3.2 Theory
Meyerhof, 1976 (based on 25mm settlement)

The allowable bearing capacity based on the SPT test according to Meyerhof is:
ga=Nego.Kd/F1 B<F4
ga=Nego.Kd.(B+F3)/(B.F2) B>F4
where Kd=1+D/(3B)<1.33 and F1 to F4 are defined as below for SI units:
F1=0.05, F2=0.08 , F3=0.30, F4=1.20

and Ng is the average SPT blow counts from 0.5B above to 2B below the foundation level.

Parry, 1977 (based on 25mm settlement)

The allowable bearing capacity according to Parry for cohesionless soil is:
qa=30Ngg Df<B

Where Ng is the average SPT blow counts below 0.75B underneath the footing.

Burland and Burbidge, 1985 (based on 25 mm settlement)

They collected more than 200 records of structures founded on sands and gravels. They started
with the premise that the settlement could be represented by an equation of the form:

qa=2540.Ngo'#/(107.B%7°)
where N60 is the average SPT blow counts to a depth of B%”® below footing and T~2.23

Peck, 1974

The following formula is used in NovoSPT for this method:
ga=10.6Ny0)

General Terzaghi Formula

The following Terzaghi equation is used for indirect estimation of bearing capacity of shallow
footing on cohesionless soil:

Quit = (ENq )+ (0-5“:'BN'.~']

where:
g = is the overburden stress at foundation level (Df).
Ny = el [tan(n/4+¢/2)]? Bowles 1996
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N, = 1.5(Ng-1).tan(¢) Brinch & Hansen 1970

¢ = friction angle correlated from the equation proposed by Hatanaka and Uchida, 1996 based on
SPT at foundation level

5.8.4 Preferences
Valid Ranges

The main aim for this tab is to control the valid ranges of output values, since some correlations
produce invalid values like sand relative density more than 100 percent or friction angle more
than 45 degrees. As it is shown on right, if the checkbox for "0 < Phi < 45" -for instance- is
removed, no checking will be carried out on calculated @ value. We highly recommend to keep all
options selected.

Options

This tab is used to specify the relative density calculation method used in Duncan (2004)
formulae.

User Interface
Use this tab to choose the input / output units system as well as user interface language.

By selecting Show help button on top-right corner of all forms, a question mark (?) button(See
5.5) will appear on top-right corner of forms, by clicking on it, help page for that page will pops

up.

Validation Rules |Dptmns | |User I.rptaface|

The following restrictions will be applied to the calculations in confarmance with
agreed range of geotechnical parameters:

0= Dr«< 100 Relative density of sands
0 < Phi « 45 Intemnal friction angle
04«<Cn=<2 Depth comection factor for SPT blow counts

0<CRR =038 Cyclic resistance ratio for liquefaction assessment

Found comelated Becker Density Test blow counts

] o=]
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5.8.5 Reporting
To prepare the reports after completing the calculations, simply click on File » Report menu. This

will bring up the report manager page, where you can choose the tables and graphs which should
be included in the report:

,

Print Input Data (SPT data, soil layers, charts)

Print All Comelations for =183 . N60=19 Print Comelation in Depth of Borehale
Select parameters: Select methods for Shear Wave Velocity (Vs):
COwerburden Comection Factor (Cn) Anbazhagan and Sitharam, 2008based on 162 data points in Bangalore) -«
Cther Comection Factors Andrés Alfaro, 2007function of NED)
Consistency Andrés Alfaro, 2007function of N60 and depth)
‘foung's Modulus (Es) Athanasopoulos, 1995For all soils)
Friction Angle Athanasopoulos. 1995For clays)
Relative Density (Dr) of Sand Baziar, Fallah, Razeghi and kKhorasani, 1998far all zoils in Iran function of d
Undrained Shear Strength (Su) of Clay/Sitt Fujiwara, 1972for all soils)
Shear Wave Velocity [Vs) Hasancebi and Ulusay, 2007for all soils)
Shear Modulus (Gmax) Hasancebi and Ulusay, 2007for sands)
Liquefaction (CRR) Hasancebi and Ulusay, 2007for clays)
Becker Hammer Test (BPT) Imai and Tonouchi, 1982far gravel)
Pressure-meter Test Imai and Tonouchi, 1982ffor all soils)
Bearing Capacity of Deep Foundations (Files) Imai and Yoshimura, 1970or all sails)
Bearing Capacity of Shallow Footings (ga) Imai and Yoshimura, 1975from 192 samples)
Settlement of Footings on Sand (S) Imai et al., 1975for all soils)
Other Soil Parameters Imai, 197 7for Quatemary and Pleistocens alluvium)
Califomia Bearing Ratio (CER) Imai, 1977 ffor sands)
Imai, 197 7for clays) -

CREECRECTS

By pressing Print button All selected tables and graphs will be summarized in the report. The
print preview page will appear and allows user to change the page setup, send the print and zoom
on the report. Toolbar buttons are described in the screenshot below:
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Previouse MNext page Zoom Page sefup Print Close page

page
\@ uvuSP“y-/R
L
L

="

Q- ¢
» o B0% | Zoom30%
»o 100% —~—+—— Zoom 100%
k 200% - Zoom 2{)(%
l'..% Zoom ouk  Chrl+Z Prass Cirl key+Z key lo zoom out
4, Zoomin Alt+Z Press Alt key+Z key to zoom in
Show 1 page on screen ————= 1 page
Show 2 pages on screen ————= 2 pages
Show 4 pages on screen — = 4 pages
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6. Online

6.1 Novo Tech Software website
http://www.novotechsoftware.com

6.2 Our other programs
http://www.novotechsoftware.com/products/

6.3 Updates
http://www.novotechsoftware.com/updatelogs/novoSPT.txt

6.4 Contact us
http://www.novotechsoftware.com/contact-us/
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